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Objectives

> After completing this module, you will be able to:

— Add directives to your design

— List number of ways to improve performance

— State directives which are useful to improve latency

— Describe how loops may be handled to improve latency

— Recognize the dataflow technique that improves throughput of the design
— Describe the pipelining technique that improves throughput of the design
— Identify some of the bottlenecks that impact design performance
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Improving Performance

» Vivado HLS has a humber of way to improve performance
— Automatic (and default) optimizations
— Latency directives
— Pipelining to allow concurrent operations
» Vivado HLS support techniques to remove performance bottlenecks
— Manipulating loops
— Partitioning and reshaping arrays
> Optimizations are performed using directives
— Let’s look first at how to apply and use directives in Vivado HLS
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Outline

» Adding Directives
» Improving Latency

— Manipulating Loops
» Improving Throughput
» Performance Bottleneck
> Summary
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Applying Directives

> If the source code is open in the GUI Information pane
— The Directive tab in the Auxiliary pane shows all the locations and objects upon which directives can
be applied (in the opened C file, not the whole design)
 Functions, Loops, Regions, Arrays, Top-level arguments
— Select the object in the Directive Tab 45 Debug [Tl ol

[ Explorer &2 ¢ = 0|[Rdetc | = O£ Outline [ Directive &
“ ” 3 H S dety 72WR_Loop_Col: < [vedtaa
* “det” function is selected ‘a:‘“‘:gudes T e (¢ = 8 ¢ < DCT_STZE; cr) Z::é:
. . . . - 74 output[r * DCT_SIZE + c] = buf[r][c]; =
B S
— Right-click to open the editor dialog box o e i
. . . = Test Bench 77
— Select a desired directive from the drop- =t frovesa ot snpuetl, short o) w
constraints | - @ output
¥ directivestel |39 . | Vivado HLS Directive Editor {1 buf 2d_in
down menu RE :zé stort buf 2 e A1 buf 2d out
- “DATAFLOW” is selected s E /) e s o oo R d
& report 85 read_data(input|| Destination
_ . . . & verilog 86 Os: Fil
Specify the Destination oo | REETEE (re
& sim O
f 189 // urite out th L
Source File Somorerfon  write satathu | = yeermn | m—rra—
« Directive File eomenc |5, 2
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Optimization Directives: Tcl or Pragma

> Directives can be placed in the directives file Vivado HLS Directve Editor s
. . . . . Type
— The Tcl command is written into directives.tcl S e =
— There is a directives.tcl file in each solution Destination
Source File
» Each solution can have different directives
Once applied the directive will be ® dct Options
(riZh‘:-v;I?clll(‘ toemc:tri?ft; Zf?ie;te) | % HLS DATAFLOW [ Hem | Cancel oK
> Directives can be place into the C source Viado H1S Diecive Edtor 0 WL
— Pragmas are added (and will remain) in the C e
. Directive: [DATAFLOW -
source file ~ —
— Pragmas (#pragma) will be used by every o dct
. . # HLS DATAFLOW Directive file
solution which uses the code | opione
78 void (shur‘t input[N], short output[N]) — I
794 [ he | [ cancel oK
20 #pragma HLS DATAFLOW N 20 B06E
81
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Solution Configurations

> Configurations can be set on a solution

— Set the default behavior for that solution
» Open configurations settings from the menu (Solutions > Solution Settings...)

[Saluliun ] Window Help

@ Solution Settings..
Run C Synthesis ) 4 “Add” or “Remove”
& Run C/RTL Cosimulation configuration settings
# Export RTL Select
& Open Analysis Perspective “General”
v |+ | solution Settings (solution1) T |

Open Report
Command:

% General 3 : q

st Configuration Settings

¥ Cosimulation | Commands ‘

A Sean Command Parameters| | Add.. AT

effort |medium
— Choose the configuration from the drop-down menu min_op

* Array Partitioning, Dataflow Memory types, Default 1O ports, RTL Settings, Operator binding, Schedule efforts
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Example: Configuring the RTL Output

> Specify the FSM encoding style

7] — i
— By default the FSM is auto ey
> Add a header string to all RTL output files onfig.nl d
— Example: Copyright Acme Inc. :::::Bium -
> Add a user specified prefix to all RTL output filenames o
— The RTL has the same name as the C functions reset [control %
— Allow multiple RTL variants of the same top-level function to be e:t\::ellhgh -
used together without renaming files
> Reset all registers
— By default only the FSM registers and variables initialized in the code are reset - —
— RAMs are initialized in the RTL and bitstream —
» Synchronous or Asynchronous reset e e

— The default is synchronous reset
> Active high or low reset

— The default is active high
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Copying Directives into New Solutions

> Select the New Solution Button
> Optionally modify any of the settings
— Part, Clock Period, Uncertainty
— Solution Name
> Copy existing directives
— By default selected
— Uncheck if do not want to copy
— No need to copy pragmas, they are in the code
» Copy any existing custom commands in to
the new script.tcl
— By default selected
— Uncheck if do not want to copy
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E ughklecr-aala-7 @

{- ] Solution Wizard

Solution Configuration

|
=

Create Vivado HLS solution for selected technology

Solution Name: solution2
Clock

Period: 10 Uncertainty:
Part Selection

part: Xc72020cig484-1 E]

Options

Copy existing directives from solution: solutionl

[ Copy existing custom constraints from solution: ~ solutionl +

[ Finish J [ Cancel
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Outline

> Adding Directives
» Improving Latency

— Manipulating Loops
» Improving Throughput
» Performance Bottleneck
> Summary
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Latency and Throughput — The Performance Factors

> Design Latency
— The latency of the design is the number of cycle it takes to output the result

* In this example the latency is | voidfoo_top (a,b,c,d,*x, *y) {
10 cycles func_ALL): —_—
e S | ANNNNNNNNIL
func_C(...) func C
func_D(...) func D func_A func_B func_C func_D
returnres; >
} Latency = 10 cycles
» Design Throughput N‘i"t wa
L New Input npu
— The throughput of the design is _the Read ——. Read
number of cycles between new inputs
+ By default (no concurrency) this is the
same as Iatency func_A func_B func_C func_D J
« Next start/read is when this transaction ends Throughput = 10 cycles -
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Latency and Throughput
> In the absence of any concurrency
— Latency is the same as throughput Next New
Input
void foo_ff)p (a,b,c,d,*x, *y) { Ne;vel: dp L Read -
func_A(...); func_A
fﬁx_B(...); func_B | | I Ll Ll Ll L| L| L| LI’LI-L
func_C(...) func C [ func_B func_C func_D
func_D(...) func_D
returnres; -
} Latency = 10 cycles

Throughput = 10 cycles

— Vivado HLS can pipeline functions and

. func_A func_B func_C func_D
loops to improve throughput S — — e b
— Latency and throughput are related >
— We will discuss optimizing for latency first Latency =10 cycles
then throughput Throughput = 4 cycles
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Vivado HLS: Minimize latency

» Vivado HLS will by default minimize latency

— Throughput is prioritized above latency
(no throughput directive is specified here) | voidfoo_top (a,b,c.d, *x, *y){
— In this example func_A(a,b,t1);

a
b — X
. func_B(a,b,t2);
» The functions are connected as shown func_C(c,t1,8x) d —y

func_D(d,t2,8y)

+ Assume function B takes longer than any |,
other functions

» Vivado HLS will automatically take advantage of the parallelism

— It will schedule functions to start| | | | | | | | | | | |

as soon as they can
* Note it will not do this for loops
within a function: by default they
are executed in sequence write x \ivritey
Latency =6 cycles

- func_A and func_B can start at the same time
- func_C can start as soon as func_A completes
« func_D must wait for func_B to complete

- Outputs are written as soon as they are ready
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Default Behavior: Minimizing Latency

» Functions
— Vivado HLS will seek to minimize latency by allowing functions to operate in parallel
+ As shown on the previous slide

> Loops
— Vivado HLS will not schedule loops to operate in parallel by default
. P . L sfor(i=1;i<3;i++) {
Dataflow optimization must be used or the loops must be unrolled Z‘:iRc:ald; LR —
» Both techniques are discussed in detail later g::\?v‘:irtl'?me; %
> Operations

— Vivado HLS will seek to minimize latency by allowing the operations to occur in parallel

— It does this within functions and within loops Example of Minimizing latency with Parallel

- Example with Sequential Operations
void foo(-) { Operations

op_Read; ~perations L1

g Cwn ] [ g )

op_Write; WR
} (RO [ cwe [ WR ] (L

Improving Performance 13- 14 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.




Latency Constraints

» Latency constraints can be specified

— Can define a minimum and/or maximum latency for the location

« This is applied to all objects in the specified scope

— No range specification: schedule for minimum
* Which is the default
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Vivado HLS Directive Editor

Type

Directive: [LATENCY

Destination
Source File

©) Directive File

Options
min (optional):

max (optional):

|
Impact of ranges {

Minimum
Specified

Maximum
Specified

Achieved < Specified

Achieved > Specified

[ RD  cMP | WR | DU

Extend with dummy (DU) cycles
and try to improve sharing

Constraint satisfied: no
further action

Constraint satisfied: no
further action

© Copyright 2013 Xilinx

[ RD CMP WR RD CMP L

Automatically increase effort to meet
constraint: if it cannot be satisfied,
create the smallest latency possible
(_(may viclate constraint) |

3

4
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Region Specific Latency Constraint

> Latency directives can be applied on functions, loops and regions
> Use regions to specify specific locations for latency constraints

— Aregion is any set of named braces {...aregion...}

» The region My_Region is shown in this example

— This allows the constraint to be applied to a specific range of code
* Here, only the else branch has a latency constraint

int write_data (int buf, int output) {

if (x<y) {
return (x +y);
}else {

My_Region: {
return (y —x) * (y + x);

}

Vivado HLS Directive Editor P

Type

Directive: | LATENCY

+| | Eoutiine [af Directive

Destination
(@ Source File
© Directive File

Select the region in the
Directives tab & right-click to -
apply latency directive

Improving Performance 13- 16
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© det 1d
© dct2d
@ read_data
© write_data

/| options 1 but
min (optionall: 3 11 output
- # My Region
max (optionali: 4 R
i
[ Hap ][ cance || J
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> Adding Directives
> Improving Latency

— Manipulating Loops
> Improving Throughput
» Performance Bottleneck
> Summary
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Review: Loops

> By default, loops are rolled
— Each C loop iteration = Implemented in the same state
— Each C loop iteration = Implemented with same resources @

void foo_top (..) {

Add: for (i=3;i>=@;i--) {
b = a[i] + b;

3 | Sisis 3

Loops require labels if they are to be referenced by Tcl directives
(GUI will auto-add labels)

— Loops can be unrolled if their indices are statically determinable at elaboration time
» Not when the number of iterations is variable
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Rolled Loops Enforce Latency

> A rolled loop can only be optimized so much
— Given this example, where the delay of the adder is small compared to the clock frequency

void foo_top (..) {
Add: for (i=3;i>=03i--) { Clock | | | | | | | |
135 EfEh] L Adder Delay (3] (2] (] (o]
}

— This rolled loop will never take less than 4 cycles
» No matter what kind of optimization is tried
+ This minimum latency is a function of the loop iteration count
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Unrolled Loops can Reduce Latency

void foo top (..) {

Add: for (i=3;i>=@;i--) {

b = a[i] + b;
Vivado HLS Directive Editor
Select loop “Add” in || 1y
the directives pane || irective: [unroLL B
and right-click | esnsten oot W W
® = . P—— nrolled loops
= ZT:'::V:I;E Option2 (&) 2 ()C0) greater option &
— - E exploration
Options Option3 5~
skip exit check: [} @
factor (optional): @
| region: [}
1 [ n ]
. Options ;xpl;ined on ne?(; - Unrolled loops are likely to result in more hardware
— slide — resources and higher area
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Partial Unrolling

> Fully unrolling loops can create a lot of hardware
> Loops can be partially unrolled

— Provides the type of exploration shown in the previous slide Ad[_d]: fo;}_i]nti =[_]0: i <N:iss) {
a[i] = b[i] + c[i];
» Partial Unrolling !
— A standard loop of N iterations can be unrolled to by a factor [ aqq:torinti=0:i<N:i+=2)(
. . 1] = bfi] + c[il;
— For example unroll by a factor 2, to have N/2 iterations ok N Brsal
e - . afi+1] = bfi+1] + cfi+1]; Effective code after
+ Similar to writing new code as shown on the right & } compiler
+ The break accounts for the condition when N/2 is not an integer transformation
— If “i” is known to be an integer multiple of N
» The user can remove the exit check (and associated logic) for(inti = 0;i < N;i += 2) {
) . . . afi] = bli] + cfil
» Vivado HLS is not always be able to determine this is true afi+1] = bli+1] + cli+1];
(e.g. if N is an input argument) i An extra adder for

N/2 cycles trade-off

+ User takes responsibility: verify!
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Loop Flattening

| Vivado HLS Directive Editor

| Type
» Vivado HLS can automatically flatten nested loops et Q0BG ATIEN :]
— A faster approach than manually changing the code i
> Flattening should be specified on the inner most loop Opsns

off:

— It will be flattened into the loop above

Help. ] Cancel
— The “off” option can prevent loops in the hierarchy from being flattened

void foo_top (..) { void foo_top (..) {

L1: for (i=3;i>=@;i--) { L1: for (i=3;i>=@;i--) {
x4 [Loop body L1 ] [Loop body L1 ]
} } x4

L2: for (i=3;i>=@;i--) { L

L3: for (j=3;3>=03j--) { » L2: for (k=15,k>=0;k--) { 16
[Loop body L3 ]

} [Loop body L3 ]

L4: for (i=3;i>=@;i--) { L4: for (i=3;i>=0;i--) {
[Loop body L4 ] [Loop body L1 ]
} ¥ x4

36 transitions | Loops will be flattened by default: use “off” to disable | 28 transitions
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Perfect and Semi-Perfect Loops
> Only perfect and semi-perfect loops can be flattened S
— The loop should be labeled or directives cannot be applied LMESZ;;%E&::Z:;%_?E3??15;-5> {
— Perfect Loops 3
— Only the inner most loop has body (contents)
— There is no logic specified between the loop statements
— The loop bounds are constant Loop_outer: for (1-3;isN3i--) {
— Semi-perfect Loops LR e it
— Only the inner most loop has body (contents) } ’
— There is no logic specified between the loop statements
— The outer most loop bound can be variable Loop_outer: for (i=3;i>N;i--) {
- Other types Loop, tmard. for (J=3:32a133--) <
— Should be converted to perfect or semi-perfect loops ) B -
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Loop Merging
Vivado HLS Directive Editor
» Vivado HLS can automatically merge loops I .
— A faster approach than manually changing the code ——
— Allows for more efficient architecture explorations &

— FIFO reads, which must occur in strict order, can prevent loop merging o

force:

» Can be done with the “force” option : user takes responsibility for correctness
l [ hep [ concel oK |
void foo_top (..) { M
L1 for (i=3;i>=0;i--) { 7] 5
x4 [Loop body L1 ] void foo_top (..) {
! 123 for (1=16,1>=0;1--) {
L2: for (i=3;i>=0;i--) { if (condl)
L3: for (3=3;3>=0;j--) { [Loop body L1 ]
{Loop body L3 ] — leaibadyiia] .
} Already flattened %5 (@
L4: for (i=3;i>=@;i--) { [Loop body L4 ]
[Loop body L4 ]
} -
_ 8 transitions
36 transitions
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Loop Merge Rules

> If loop bounds are all variables, they must have the same value
> If loops bounds are constants, the maximum constant value is used as the bound of the
merged loop

— As in the previous example where the maximum loop bounds become 16 (implied by L3 flattened into
L2 before the merge)

> Loops with both variable bound and constant bound cannot be merged
> The code between loops to be merged cannot have side effects
— Multiple execution of this code should generate same results
» A=B is OK, A=B+1 is not
> Reads from a FIFO or FIFO interface must always be in sequence
— A FIFO read in one loop will not be a problem

— FIFO reads in multiple loops may become out of sequence
« This prevents loops being merged
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Loop Reports

» Vivado HLS reports the latency of loops
— Shown in the report file and GUI
» Given a variable loop index, the latency cannot be reported
— Vivado HLS does not know the limits of the loop index
— This results in latency reports showing unknown values
> The loop tripcount (iteration count) can be specified
— Apply to the loop in the directives pane
— Allows the reports to show an estimated latency | Impacts reporting — not synthesis

Performance Estimates Vivada HLS Dirctive Editor Performance Estimates

= Timing (ns) 2 = Timing (ns)
Directive: |LOOP_TRIPCOUNT

= Summary = Summary

Clock  Target Estimated Uncertainty Clock  Target Estimated Uncertainty
default 1000 874 125 default  10.00 874 125
= Latency (clock cycles)

= Latency (clock cycles)

= Summary
Latency Interval

= Summary

Latency Interval

min max min max  Type
Hep Concel ox

561205 34417925 561206 34417926 none
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Techniques for Minimizing Latency

» Constraints
— Vivado HLS accepts constraints for latency

> Loop Optimizations
— Latency can be improved by minimizing the number of loop boundaries
* Rolled loops (default) enforce sharing at the expense of latency
» The entry and exits to loops costs clock cycles
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Outline

> Adding Directives
> Improving Latency

— Manipulating Loops
> Improving Throughput
» Performance Bottleneck
> Summary
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Improving Throughput

» Given a design with multiple functions
— The code and dataflow are as shown

void foo_top (a,b,c,d, *x, *y) {

func_A(a,b,t1); g func_A a func_B ¢ func_C d func_D —Y
func_B(a,t1,t2); X
func_C(c,t2,8x)
func_D(d,x,&y)

}
» Vivado HLS will schedule the design

| | I | I | I | I | I | I | I | I | The latencyis 9 The throughput is

func_A func_B func_C [ cycles also 9 cycles

> It can also automatically optimize the dataflow for throughput

The latency is still
x y o y x 9 cycles

D The throughputis
£ now3
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Dataflow Optimization

» Dataflow Optimization
— Can be used at the top-level function
— Allows blocks of code to operate concurrently

» The blocks can be functions or loops
+ Dataflow allows loops to operate concurrently

— It places channels between the blocks to maintain the data rate

A Channel B Channel C

+ For arrays the channels will include memory elements to buffer the samples
* For scalars the channel is a register with hand-shakes
> Dataflow optimization therefore has an area overhead
— Additional memory blocks are added to the design
— The timing diagram on the previous page should have a memory access delay between the blocks
» Not shown to keep explanation of the principle clear
Improving Performance 13- 30 © Copyright 2013 Xilinx £ XILINX » ALL PROGRAMMABLE.




Dataflow Optimization Commands

> Dataflow is set using a directive

— Vivado HLS will seek to create the highest performance design
+ Throughput of 1

r

Vivado HLS Directive Editor

Type
Directive: | DATAFLOW >

Destination
Source File
(@ Directive File

Help ] [ Cancel ] I OK

Improving Performance 13- 31 © Copyright 2013 Xilinx & XILINX » ALL PROGRAMMABLE.

Dataflow Optimization through Configuration Command

» Configuring Dataflow Memories
— Between functions Vivado HLS uses ping-pong memory buffers by default
» The memory size is defined by the maximum number of producer or consumer elements
— Between loops Vivado HLS will determine if a FIFO can be used in place of a ping-pong buffer
— The memories can be specified to be FIFOs using the Dataflow Configuration

» Menu: Solution > Solution Settings > config_dataflow A - [
» With FIFOs the user can override the default size of the FIFO _—
 Note: Setting the FIFO too small may result in an RTL verification failure R %

Parameters

> Individual Memory Control
— When the default is ping-pong fifodeptn 2
+ Select an array and mark it as Streaming (directive STREAM) to implement the array as a FIFO
— When the default is FIFO

+ Select an array and mark it as Streaming (directive STREAM) with option “off” to implement the array as a ping-
pong

default_channel [fifo =

To use FIFO’s the access must be sequential. If HLS determines that the access is not
sequential then it will halt and issue a message. If HLS can not determine the sequential
nature then it will issue warning and continue.
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Dataflow : Ideal for streaming arrays & multi-rate functions

> Arrays are passed as single entities by default

— This example uses loops but the same principle applies to functions
inta[N], b[N], c[N];

e w2
:
mefzif:f (i=.:;,‘i,_<="'1;iH” : Finish allwrites u ThenLoop_2canstartto
CIEENHAE to bIN]... access b[N]

> Dataflow pipelining allows loop_2 to start when data is ready

— The throughput is improved [ | | | | | | | | | |

— Loops will operate in parallel Loop_1
. If dependencief allow (b0 [ b1 | b2 [ b3 |
» Multi-Rate Functions L ez
— Dataflow buffers data when one function or loop consumes or produces data at different rate from others

> 10 flow support

— To take maximum advantage of dataflow in streaming designs, the 10 interfaces at both ends of the datapath
should be streaming/handshake types (ap_hs or ap_fifo)
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Pipelining: Dataflow, Functions & Loops

> Dataflow Optimization
— Dataflow optimization is “coarse grain” pipelining at the function and loop level
— Increases concurrency between functions and loops
— Only works on functions or loops at the top-level of the hierarchy
+ Cannot be used in sub-functions

» Function & Loop Pipelining
— “Fine grain” pipelining at the level of the operators (*, +, >>, etc.)
— Allows the operations inside the function or loop to operate in parallel
— Unrolls all sub-loops inside the function or loop being pipelined
+ Loops with variable bounds cannot be unrolled: This can prevent pipelining
+ Unrolling loops increases the number of operations and can increase memory and run time
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Function Pipelining

Without Pipelining

With Pipelining

void foo(...) {
op_Read;
op_Compute;
op_Write;

}

_ Throughput = 3 cycles

[ ro [ cw [ wr | RO | cwp [ wrR ]

Latency = 3 cycles

» There are 3 clock cycles before operation RD can
occur again
— Throughput = 3 cycles
» There are 3 cycles before the 13 output is written
— Latency = 3 cycles
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Throughput = 1 cycle

Eg

(R [ cwe [ WR ]
>

Latency = 3 cycles
» The latency is the same

» The throughput is better
— Less cycles, higher throughput
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Loop Pipelining

Without Pipelining

With Pipelining

Loop:for(i=1;i<3;i++) {
op_Read;
op_Compute;
op_Write;

}

Throughput = 3 cycles _

CWP | _WR | RD | CMP | WR

T

Latency = 3 cycles

Loop Latency = 6 cycles
» There are 3 clock cycles before operation RD can
occur again
— Throughput = 3 cycles
> There are 3 cycles before the 13t output is written
— Latency = 3 cycles
— For the loop, 6 cycles
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Throughput = 1 cycle

o Iy

J

_Latency = 3 cycles
Loop Latency =4 cycles

» The latency is the same

— The throughput is better
— Less cycles, higher throughput

» The latency for all iterations, the loop latency, has been
improved
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Pipelining and Function/Loop Hierarchy

» Vivado HLS will attempt to unroll all loops nested below a PIPELINE directive
— May not succeed for various reason and/or may lead to unacceptable area
* Loops with variable bounds cannot be unrolled
 Unrolling Multi-level loop nests may create a lot of hardware
— Pipelining the inner-most loop will result in best performance for area
» Or next one (or two) out if inner-most is modest and fixed
» e.g. Convolution algorithm
* Outer loops will keep the inner pipeline fed

void foo(in1[ ][], in2[ ][], -..) { void foo(in1[ (], in2[ ][], ...) { void foo(in1[ ][], in2[ ][], -.-) {
#pragma AP PIPELINE
L1:for(i=1;i<N;i++) { L1:for(i=1;i<N;i++) {
L2:for(j=0;j<M:j++) { #pragma AP PIPELINE L1:for(i=1;i<N;i++) {
#pragma AP PIPELINE L2:for(j=0;j<M:j++) { L2:for(j=0;j<M;j++) {
g outfi][j] = in1[i][j] + in2[i][j}; g outfi][j] = in1[i][] + in2[i][j}; out[i][j] = in1[i]fi] + in2[i][j};
}
} } }
} } }

1adder, 3 accesses ‘ Unrolls L2 Unrolls L1 and L2
M adders, 3M accesses N*M adders, 3(N*M) accesses
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Pipelining Commands

» The pipeline directive pipelines functions or loops .
. . . . . e Vivado HLS Directive Editor
— This example pipelines the function with an Initiation

Type
Interval (I1) of 2 =
. . . Directive: |PIPELINE -
» The Il is the same as the throughput but this term is used
exclusively with pipelines Destination
Source File

[ L @) Directive File

€«———> ([ R [ ow [ WR ] )

Initiation Interval (or Il) Options
1 (optional): 2

» Omit the target Il and Vivado HLS will Automatically | ¢ ushing
pipeline for the fastest possible design

— Specifying a more accurate maximum may allow more
sharing (smaller area) - g

[ Help J [ Cancel J [ oK
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Pipeline Flush

> Pipelines can optionally be flushed

— Flush: when the input enable goes low (no more data) all existing results are flushed out
» The input enable may be from an input interface or from another block in the design
— The default is to stall all existing values in the pipeline

Without Flush (default) With Flush (optional)

Data Valid | | Data Valid | |

(A ] ow | WA ) owt (R [ cw [ wr )N
(r ] cmp [ wrcEENN RD cmp WR
(A [ ow ] [ R | cw

> With Flush
— When no new input reads are performed
— Values already in the pipeline are flushed out
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Pipelining the Top-Level Loop

» Loop Pipelining top-level loop may give a “bubble”
— A “bubble” here is an interruption to the data stream
— Given the following

void foo_top (in1, in2, ... {

ASgEpsy

L1: Accum Init

static accum=0; L1: Accum

L1:for(i=1;i<N;i++) {

)acclln:accunfim +in2; - > >
out1_data = accum; p:;ﬁ;;ie:g “bubble” Next
rar
3} of data : Pipelined
processing
of data

— The function will process a stream of data
— The next time the function is called, it still needs to execute the initial (init) operations
« These operations are any which occur before the loop starts
« These operations may include interface start/stop/done signals
— This can result in an unexpected interruption of the data stream
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Continuous Pipelining the Top-Level loop

> Use the “rewind” option for continuous pipelining

— Immediate re-execution of the top-level loop Vivado HLS Directive Editor
. . T
— The operation rewinds to the start of the loop 5
Directive: | PIPELINE 7
* Ignores any initialization statements before the start of the loop i
void foo_top (in1, in2, ...) { 2Ll
L1: Accum L1: Accum L1: Accum © Directive File
static accum=0;
Options.
L1:for(i=1;i<N;i++) { N N N 1 (optional):
accum = accum +in1 +in2; o - > . 2
Pipelined Next enable flushing: 4
out1_data = accum; processing || transaction: enable loop rewinding: 7]
}“' of data. Pipelined
processing Help 1 l Cancel I I 0K
of data

> The rewind portion only effects top-level loops
— Ensures the operations before the loop are never re-executed when the function is re-executed
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Issues which prevent Pipelining

» Pipelining functions unrolls all loops
— Loops with variable bounds cannot be unrolled
— This will prevent pipelining
* Re-code to remove the variables bounds: max bounds with an exit
> Feedback prevent/limits pipelines
— Feedback within the code will prevent or limit pipelining
» The pipeline may be limited to higher initiation interval (more cycles, lower throughput)

void foo_top (a,b,c.d) {
while (a 1=b) { - M -
=) Q==
eIseb——a: : —
e =1
be
» Resource Contention may prevent pipelining

— Can occur within input and output ports/arguments
— This is a classis way in which arrays limit performance
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Resource Contention: Unfeasible Initiation Intervals

» Sometimes the Il specification cannot be met
— In this example there are 2 read operations on the same port

id fi 2]...
(A) Pipeline with ll=1 gsidiee(miz].LL (B) Pipeline with ll=2

op_Read_m[0]: RD
op_Read_m[1]; RO | | I

] " op_Compute; | cmp y 4

(R0 [ Po. | cMP [ WR | op_Write; [ wr [ RO [ RD  cwp [ WR |

> [ R0 | cwp [ wR | } (Tl RD [ RD | cWP [ WR |

=1 =

— An II=1 cannot be implemented
» The same port cannot be read at the same time
« Similar effect with other resource limitations
» For example if functions or multipliers etc. are limited
» Vivado HLS will automatically increase the Il
— Vivado HLS will always try to create a design, even if constraints must be violated
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Outline

> Adding Directives
> Improving Latency

— Manipulating Loops
> Improving Throughput
» Performance Bottleneck
> Summary
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Arrays : Performance bottlenecks

> Arrays are intuitive and useful software constructs
— They allow the C algorithm to be easily captured and understood
> Array accesses can often be performance bottlenecks

— Arrays are targeted to a default RAM
» May not be the most ideal memory for performance

void foo_top (...) { |=] ﬁ OI‘ ﬁ ﬁ
;'.(.Jr(i=2:i<N:iﬂ-) “‘
mem([i] = mem([i-1] +mem[i-2];

}
}

Even with a dual-port RAM, we cannot
perform all reads and writes in one cycle

+ Cannot pipeline with a throughput of 1
» Vivado HLS allows arrays to be partitioned and reshaped
— Allows more optimal configuration of the array
— Provides better implementation of the memory resource
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Review: Arrays in HLS

> An array in C code is implemented by a memory in the RTL
— By default, arrays are implemented as RAMs, optionally a FIFO

A[N]

void foo_top(int x, ...) *
{

int A[N]; N2

L1: for (i = 0; i < N; i++) [

Ali+x] = A[i] +i;
*
*

» The array can be targeted to any memory
resource in the library
— The ports and sequential operation are

defined by the library model e
+ All RAMs are listed in the Vivado HLS Library Guide a\éaglrzl:e
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Array and RAM selection

» If no RAM resource is selected
— Vivado HLS will determine the RAM to use
« It will use a Dual-port if it improves throughput
+ Else it will use a single-port
> BRAM and LUTRAM selection
— If none is made (e.g. resource RAM_1P used) RTL synthesis will determine if RAM is implemented as

BRAM or LUTRAM
— If the user specifies the RAM target (e.g. RAM_1P_BRAM or RAM_1P_LUTRAM is selected ) Vivado

HLS will obey the target
 If LUTRAM is selected Vivado HLS reports registers not BRAM
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Array Partitioning

Vivado HLS Directive Editor

» Partitioning breaks an array into smaller elements e
— If the factor is not an integer multiple the final array has fewer elements | Directive: [ARRAY.PARTITION bt
— Arrays can be split along any dimension s
« If none is specified dimension zero is assumed || @ Drrective Fie
Options
» Dimension zero means all dimensions v:;m (required):  buf 2d_in
e lepio:

— All partitions inherit the same resource target
factor (optional):
» That is, whatever RAM is specified as the resource target d”:ensi;t(owwu .

» Except of course “complete’
P P P S p— llZ0l | Dividedinto blocks:
block N-1/factor elements
i

array1[N] - - | Dividedinto blocks:
3 i 1word at a fime
M -y i I T T T 7 | (like “dealing cards”)
Individual elements:
N s Break a RAM into
compl| L] | reaisters (no “factor®

Multiple memories allows e supported)
greater parallel access - =

£ XILINX » ALL PROGRAMMABLE.
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Configuring Array Partitioning

» Vivado HLS can automatically partition arrays to improve throughput “ e
— This is controlled via the array configuration command ‘-- S -
— Enable mode throughput_driven Parameters
. . . . auto_partition_threshold 4
» Auto-partition arrays with constant indexing e ] |
— When the array index is not a variable e !
— Arrays below the threshold are auto-partitioned Sk 2s

throughput_driven

— Set the threshold using option elem_count_limit
> Partition all arrays in the design
— Select option scalarize_all
> Include all arrays in partitioning [ conca ]
— The include_ports option will include any arrays on the 1O interface when partitioning is performed

« Partitioning these arrays will result in multiple ports and change the inteface
« This may however improve throughput

— Any arrays defined as a global can be included in the partitioning by selecting option include_extern_globals
« By default, global arrays are not partitioned

Improving Performance 13- 49 © Copyright 2013 Xilinx &£ XILINX » ALL PROGRAMMABLE.

Array Dimensions

» The array options can be performed on dimensions of the array
my_array[10][6][4]

dimension (optional): 1 ‘ ‘ Dimension 1 _T |
Dimension 2
Dimension 3

Dimension 0 j

(All dimensions)

>» Examples my_array_O[10][6]
my_array[10][6][4] <> partition dimension 3 > 2&2;:3:;{}8}{2} 2&2;2&?{2}{3}
my_array_3[10][6] my:array:2[6][4]

my_array_3[6][4]
my_array_4[6][4]
my_array_5[6][4]
my_array_6[6][4]
my_array_7[6][4]
my_array_8[6][4]
my_array_9[6][4]

v

my_array[10][6][4] => partition dimension 1

my_array[10][6][4] =>» partition dimension 0 => 10x6x4 = 240 individual registers
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Array Reshaping

> Reshaping recombines partitioned arrays back into a single array | vido s oiecve eaitor

— Same options as array partition

— However, reshape automatically recombines
the parts back into a single element

— The “new” array has the same name
» Same name used for resource targeting

Type
Directive: |ARRAY_RESHAPE -

Destination

(©) Source File

©) Directive File

Options

variable (required): buf 2d_in

object: 1}

complete -

type (optional):

factor (optional):

dimension (optional): 1

—
array1[N] MSB
P G S
Read modify write is
not allowed: read the m et
whole word or write .

the whole word
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Similarto converting a RAM info a very wide
register - great access, high throughput

£ XILINX » ALL PROGRAMMABLE.

Structs and Arrays: The Default Handling

» Structs are a commonly used coding construct
— By default, structs are separated into their separate elements

typedef st

unsigned char A;
4-element unsigned char B_[ti];
array unsigned char C;

1my. data:

void foo(my_data*a)

5l
RiE e
¥

Interface

Internals

8-bit
8-bit Memory port™
8-bit

*Assumes no array partitioning {
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» Treated as separate elements

* On the Interface

— This means separate ports
* Internally

— Separate buses & wires

— Separate control logic, which may be more
complex, slower and increase latency
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Data Packing

> Data packing groups structs internally and at the 10 Interface
— Creates a single wide bus of all struct elements

typedaf struct{
§§E§w « Grouped structure
Jmy. data; — First element in the struct becomes the LSB
W_r\ vord foaimy. gata"a) — Last struct element becomes the MSB
s ristsinet — Arrays are partitioning completely
partones @ = + On the Interface
Interface Internals — This means a single port
* Internally
— Single bus
e hpte - May result in simplified control logic, faster

and lower latency designs
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Outline

> Adding Directives
> Improving Latency

— Manipulating Loops
> Improving Throughput
» Performance Bottleneck
> Summary
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Summary

> Directives may be added through GUI
— Tcl command is added into script.tcl file
— Pragmas are added into the source file
> Latency is minimized by default
— Constraints can be set
> Loops may have impact on the latency
> Throughput may be improved by pipelining at
— The task, function, and loop level
» Arrays may create performance bottleneck if not handled properly
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Summary

» Optimizing Performance
— Latency optimization
« Specify latency directives
+ Unroll loops
» Merge and Flatten loops to reduce loop transition overheads
— Throughput optimization
+ Perform Dataflow optimization at the top-level
+ Pipeline individual functions and/or loops
+ Pipeline the entire function: beware of lots of operations, lots to schedule and it's not always possible
— Array Optimizations
» Focus on bottlenecks often caused by memory and port accesses
» Removing bottlenecks improves latency and throughput
= Use Array Partitioning, Reshaping, and Data packing directives to achieve throughput
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Obijectives

> After completing this lab, you will be able to:

— Add directives to your design

— Understand the effect of INLINE-ing functions

— Observe the effect of PIPELINE-ing functions

— Improve the performance using various directives
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The Design

— Each of these functions iterates over the
entire source image, requiring a single
source pixel to produce a pixel in the result
image

— The scale function simply applies individual
scale factors, supplied through top-level
arguments

> The design consists of YUV filter typically used in video processing. The design
consists of three functions — rgb2yuv, yuv_scale, and yuv2rgb

// The top-level function
wvoid yuwv_filter (
image_t *in,
image_t *out,
vuv_scale_t ¥Y_scale,
vuv_scale_t U_scale,
yuv_scale_t V_scale

)

{

// Internal image buffers

#ifndef _ SYNTHESIS_
image_t *yuv = (image_t *)malloc(sizeof(image_t));
image_t *scale = (image_t *)malloc(sizeof(image_t)});

#else // Workaround malloc() calls w/o changing rest of code
image_t _yuv;
image_t _scale;
image_t *wuv = & vuw;
image t *scale = & scale;
#endif

reb2yuv (in, wyuv);
yuv_scale ( vuv, scale, ¥Y_scale, U_scale, V_scale);
yuv2rgb 4 scale, out);

¥
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Procedure

> Create a Vivado HLS project by executing script from Vivado HLS command prompt
> Open the created project in Vivado HLS GUI and analyze

> Apply TRIPCOUNT directive using PRAGMA

> Apply PIPELINE directive, generate solution, and analyze output

> Apply DATAFLOW directive to improve performance

> Export and Implement the design
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Summary

> In this lab you learned that even though this design could not be pipelined at the top-
level, a strategy of pipelining the individual loops and then using dataflow optimization
to make the functions operate in parallel was able to achieve the same high throughput,
processing one pixel per clock. When DATAFLOW directive is applied, the default
memory buffers (of ping-pong type) are automatically inserted between the functions.
Using the fact that the design used only sequential (streaming) data accesses allowed
the costly memory buffers associated with dataflow optimization to be replaced with
simple 2 element FIFOs using the Dataflow command configuration
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